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Chapter 1 
Introduction to Computer 
Operations  
 

 
 

Chapter One is designed for those who are new to the computer or who are just beginning users.  
The instructor can move at the pace that best fits the skill level of the class participants.  It begins 
with “operating the mouse” and moves through learning about Windows and concludes with 
entering and formatting text. 
 
The Mouse 
 
A standard PC mouse has left and right mouse buttons. The left button is the primary mouse 
button and is used to open programs and make selections from menus. Moving the mouse 
moves the mouse pointer on the computer screen.  The mouse also has a wheel in the center 
that is used to move up or down in a document by rolling the wheel. Some have a large ball 
that is rotated to move the mouse pointer on the screen. 
 
Notebook or laptop computers often have a flat surface at the bottom of the keyboard that 
serves to move the mouse pointer.  The mouse can be activated by tapping on the screen.  
There is also two buttons below or above the flat-surface mouse to use to activate the 
mouse.  
 
Using the Mouse 
 
Move the mouse pointer to the Start button on the lower left side of the computer.  Click the left 

mouse button once to view a short menu of the programs available on the 
computer. 
 
Click the Start button again, and the Start menu will close. Or, click outside the 

menu box to close it. 
 
Now, find the Internet Explorer Icon on the screen and click once. The icon, or picture, is 

highlighted, but nothing more happens. Now quickly click the left mouse button twice. 
Internet Explorer opens in a new window.  Close the window by clicking on the black 
“X” found in the upper right corner of the screen.  Reopen Internet Explorer by 
clicking twice on the icon on the desktop. 

 
 
To open programs, click the mouse button twice. When working within a program like WordPad or 
Internet Explorer, click once with the left mouse button to perform a task.  Look for the word File 
in the upper left corner of the computer screen in the Internet Explorer window.  Position the 
mouse pointer on it and click once with the left button.  
 
The File pull down menu opens and lists the functions of the program such as Open, Print, Send, 
etc. that can be used with a left click of the mouse. Move the mouse pointer to the X in the upper 
right hand corner of the window. Click once on this Close button with the left mouse button to 
close Internet Explorer. 
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The Right Mouse Button 
 
The right button is the secondary mouse button. Click the right button over a program title or icon 
and a short menu will appear. This will be a menu with the appropriate choices for the application 
being run at the time.  Click with the left mouse button to act on one of the choices, or left click 
outside the menu box to close it.  New computer users may inadvertently click the mouse button 
in unfamiliar territory and be concerned about continuing. When this happens there are several 
remedies. 1)press the Escape (Esc) key;  2)click the mouse pointer in a neutral area of the 
screen; or 3)close the window by clicking with the left mouse button on the X box in the upper 
right corner of the screen to return to the previous window. 
 
The Mouse Pointer 
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The mouse pointer takes on various appearances on the screen. The mouse pointer 
usually appears as an arrow. 

 
When the mouse pointer is over text within a program, it appears an “I beam.”  This is 
called the cursor. Click the left mouse button, and the cursor will blink. When the cursor is 
blinking, the computer is ready for a command such as typing in text or pasting in an 

image.  
 

When the mouse pointer changes to an hourglass the computer is performing an 
assigned task. Wait until the hourglass disappears before commanding the computer to 
perform yet another task. 

 
 If text is underlined or changes color, it is an indication of a link to the Internet. The mouse 
pointer may turn into an image of a small hand, meaning that the text is clickable. Click on 
the text to launch the Internet browser and go to the indicated website. 

 
When working with images and graphics the mouse pointer turns into a “double arrow” 
which is used for resizing. 

 
When the mouse pointer turns into “cross arrows” text or an image can be “drug” to 
another location on the screen. 

 
 
Windows Desktop 
 
When the computer is booted up, the first screen that appears is known as the desktop.  It 
usually has a colored background or image with many icons installed on it. The Windows desktop 
is like a physical desk with documents on it.   
 
My Computer, My Network Places, and Recycle Bin are example icons 
found on most computer desktops.  
 
Other icons are found on the desktop which are 
shortcuts to other programs or applications installed 
on the computer. Generally, an icon is placed on the 
desktop when a program is installed.  

http://www.google.com/imgres?imgurl=http://www.eatt.org/en/ZT%2520Student%2520Book%2520Part%25201%2520Oct06_files/image025.jpg&imgrefurl=http://www.eatt.org/en/training_ZT_student_part1.php&h=48&w=37&sz=0&tbnid=bkTfV9ranwgJ:&tbnh=48&tbnw=37&sa=X&oi=image_result&resnum=1&ct=image&cd=3�
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When the mouse pointer hovers over one of these icons before the left mouse button is clicked, 
an information box appears to explain what the icon represents. 
 
To open a program from a short cut icon, simply  
“double click” on it with the left mouse button.“double click” on it 
with the left mouse button. 
 
 
Start Button Menu 
 
Start Button - Generally, there is more than one way to accomplish tasks on a computer. Not all 
programs have icons, or the user may choose not to use them to open programs. To launch a 
program 
or task, click the Start Button in the lower left corner to view a menu of programs, applications, 
etc. 
 
 
 
Programs - lists all the programs installed 
on the computer, as well as special features 
or tasks associated with the program. Hold 
the mouse pointer on this button to see the 
applications installed on the computer.  
 
Notices in the image to the right, some of 
the programs have an ‘arrow’ pointing to the 
right beside them.  This indicates there are 
more choices for opening the program. 
 
 
 
 
 
 
 
 
 
 
 
Documents - includes a list of the most recently used files or accesses files that are stored in the 
My Documents folder on the hard drive. 
 
Search (Find) - Search or Find allows the user to search for a file, program, folder, etc. Left click 
on this button to view another menu or option. Click on (All) Files or Folders and when another 
menu appears, type the filename or words contained in the document or program.  
 

           

Run - Allows installation of programs that might not have setup wizards incorporated to 
automatically begin the setup process. Follow the installation instructions that come with the 
program software. 
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Help/Support - Displays topics and information to assist the user to learn how to use Windows. 
Or, 
click on the F1 key in the upper left hand area of the keyboard. 
 
Shut down - Always turn the computer off using the shut down feature. Failure to properly shut 
down the computer will cause the machine to take longer the next time it is turned on because it 
will scan the hard drive for file errors before opening Windows. 
 
Settings - allows access to various areas of the computer such as the Control Panel or Printers 
folder where the computer settings can be modified. An example of when to change the settings 
is when installing drivers for a printer (Add Printer). These drivers enable the printer and 
computer to interact. 
 
This can be a DANGER ZONE for novice computer users! Do not change computer settings 
without a clear understanding of the process. The Help feature can be reassuring and can help 
the novice user build new skills. In earlier versions of Windows, click on Help to view the 
information by choosing either index, contents, or search. 
 
Opening, Resizing, Moving, and Exiting Windows 
 
If Internet Explorer is not open, double click on its 
icon.  When the window opens, the Title Bar will 
appear at the top of the screen.  Located at the far right end of the Title Bar are three buttons 
called minimize, restore down, or close. By moving the mouse over them, a window opens 
which explains what each does.   
 
Minimize - To minimize a window, click on the minus (-) button in the upper right corner. This 
does not close the program, but makes the window disappear. The program is still running and 
now appears in the Task Bar near the bottom of the screen.  To bring it back, simply click on it in 
the Task Bar. 
 
Restore Down/Maximize - By clicking the center button of the three buttons, (the one that looks 
like two windows) the window will be partially minimized. It will not disappear but will get smaller.  
 
Now notice the button appears as one window.  This means it is in the Restore mode.  Click it 
again, to restore the window to full size.  
 
Moving a Window - When the window is in this mode (less than full size), it can be moved and 
repositioned on the desktop. Place the mouse pointer in the colored portion of the Title Bar and 
hold the ‘left mouse’ button down to move the window around on the screen.  Practice with the 
Internet Explorer window. 
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Resizing a Window - To change the size of a window, move the pointer to the edge of the 
window on one side. The pointer will change from a single arrow to a double arrow. Hold down 
the left mouse button and move the edge of the window to make it smaller or larger. This will 
change the vertical or horizontal size of the window, depending on where the mouse pointer has 
touched the edge of the window. Move the pointer to one of the lower corners of the window and 
hold the left mouse button to change the single arrow to a diagonal arrow to resize the screen in 
both directions at one time. 
 
Exit - (X) - Click this button to exit the program.  When we do this we exit completely out of the 
program.  To get back into it must be reopened, by double click on its icon on the computer 
screen.   
 
The Active Window 
 
When two or more programs or applications are open at the same time, one window is active and 
responds to keystrokes. The active window will be on top of the other program windows. The title 
of the active window at the top of the screen will be brightly titled, and the title of the inactive 
window is less vivid.   Notice in the example below, Windows Live Messenger, MS Word, Internet 
Explorer, and Microsoft Excel are all open and running.  Microsoft Excel is the program that is 
currently open and being used. 
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Basic Computer Operations Using Microsoft Word  
 
Word Processors are very useful programs used to create documents such as letters, forms, 
cards, brochures, and newsletters.  Documents can be saved for further for further use and/or 
editing.  It can also be sent to someone else as an attachment to an email message.   
 
Starting the Program 
 
Windows – Click on Start in the lower left corner of the desktop, move up to Programs, find 
Microsoft Office, and move the mouse to the right and down to select Microsoft Word.  If your 
computer has a shortcut icon on the Desktop, simply double click with the left mouse button to 
open the program.  Also, after clicking on the Start button, scroll up through the menu above.  
This menu stores many commonly accessed programs. If Microsoft Word is in this list just click 
on it with the left mouse button.  This will open the program too. 

You will see a screen like the one below commonly knows as the Application Screen. Let’s review 
the Microsoft Windows screen.  

 

 

Menu Bar 

Formatting 
Toolbar 

Scroll Up 

Scroll Up to 
Next Page 

Closes the Word 
Program 

Scroll Down 

Scroll Right 

Office Assistant – 
Type questions 
when you need 
help 

Title Bar 

Standard 
Toolbar 

           

© 2008, The Board of Regents of  the University of Nebraska on behalf of the University of Nebraska–Lincoln Extension.  All rights reserved.               6      
 



 

Chapter 1 
Introduction to Computer 
Operations 

 
 
 
 
Title Bar - The Title Bar is at the top of the screen in all Windows XP programs. If the default 
settings on the computer are active, the Title Bar will be blue. The name of the open program is 
indicated in the blue bar, e.g., Word, Excel, Internet Explorer, Word Perfect, etc. If a file within the 
program is named, the title bar will show the name of the file as well.   Notice, the title bar below 
indicates Microsoft Word is open and the current document is chapter one. 
 

 
 
 
 
Just below the Title Bar is the Pull-Down Menu Bar. It is similar in all programs. In a word 
processing or browser program the words File, Edit, and View can be seen, for example. The 
commands on the menu are specific to the program currently in use. 

 

Many of the commands in the Menu Bar can more easily be accessed using the toolbars. The 
toolbars shown are the Menu, Standard and Formatting; they contain what Microsoft considers to 
be the most common commands. These bars can be customized according to the user. Following 
is a brief description of some of the tool bars. 
 
 
 
To see the options within each, click once on the word 
and the drop down menu will appear.  Following is the 
window that appears when clicking on “File.” 
Notice the options that appear when the File menu tab 
is clicked.  This is where we go to open a file, save a 
file, or print a file.  Also in MS Word, this is where we go 
to change margins and page layout under Page Setup. 
 
Also the previous four files that were opened in MS 
Word are found at the bottom of this window.  These 
files can be opened by clicking on them with the left 
mouse button. 
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Standard Tool Bar 
 
The standard tool bar is found below the menu bar.  It features many shortcuts commonly used 
while using MS Word.  Scroll the mouse over each of them and a window will pop open which 
tells the user what it does.  The diagram below shows many of the shortcuts. 
 

 
Click to open, 
save, or send a 
document as 
e-mail. 

  
Cut, copy, 
and paste 
objects or 
text. 

 Link to the Web, 
create tables, insert 
spreadsheets, or add 
columns or WordArt. 

  
Show the 
Office 
Assistant. 

 

 Print a 
document, 
preview 
printing, or 
check spelling. 

 Undo or 
redo any 
action. 

 Zoom, view markers, 
or select a 
magnification. 

 More 
buttons
. 

 
 
Ruler bar 
The ruler (optional) tells you the width of your document as well as the margins and tab stops. To 
make the ruler appear or disappear, go to the View menu and click on the Ruler option.  
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Text Area 
 
 
Just below the ruler is a large area called the "text area."  The blinking vertical line in the upper 
left corner of the text area is the cursor. It marks the insertion point. As you type, your work will 
show at the cursor location. The horizontal line next to the cursor marks the end of the document.  
 

 
 
The View Bar found in the lower left corner of the text area gives various ways of viewing the 
document.  There are five different ways to view a document which are shown in the lower left 
corner of the screen. 
 

 
 
They are shortcuts that allow the user to view in a normal mode, online layout, web layout, page 
layout view, and outline view.  Individually select them to review each mode. 
 
Beneath the content window is found the Status Bar.  It gives information about the document 
being created such as the current page, number of pages and the location of the cursor. 
 

 
 
 
 

Status bar 

Task bar Quick Launch bar 
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Task Bar - The Task Bar usually is located at the bottom of the screen. This bar includes the 
Start button and short cuts to other tasks related to operating the computer. 
  
The Quick Launch Toolbar is found to the right of the Start button on the Task Bar.  It features 
shortcuts to more commonly used programs on the computer.  
 
On the far right side of the task bar are icons that represent programs that automatically run when 
the computer is logged on.   Also depending on how the computer is configured, the clock and or 
date are found at the right end of the task bar. 
 

  
 

Inserting Text 

To insert text, begin typing.  The text will show where the cursor is located on the screen.  Type a 
short paragraph into the text area. 

Inserting and Deleting Text 
To insert text within a line or word, place the cursor where it is to be inserted and type in the new 
text.  To delete text, place the cursor to the left of the text to be deleted and hit the “delete” key.  If 
the cursor is on the right of the text to be deleted, the “backspace” key can also be used to delete 
the text. 

Formatting Text 
Text can be formatted in many different ways.  Text size and font can be changed.  It can be 
underlined, bold, and in different colors.  To format text, it must first be highlighted.  This can be 
done with the mouse by placing the mouse pointer to the left of the text to be formatted.  Hold the 
left mouse button down and move the mouse to the right.  To format rows pull the mouse down.   
 
tip: text can also be highlighted by holding the “shift” key down and moving the cursor 
with the arrow keys found at the lower right of the keyboard. 
 
This text is highlight or selected. 
 
After the text is highlighted, release the mouse button and point to the darkened text.  Click with 
the right mouse button and select font.  A window similar to the one below will appear.   The 
same window is found by going to format on the menu bar and selecting font. 
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Notice in this window there are many choices.  The font, style, and size can be selected from the 
top three windows.  In the middle of the window, the font color, underline, and underline color are 
choices.  The lower part of the window has options for various effects.  Notice as each is selected; 
the changes appear in the preview window below. 
 
Examples: 
 
This text is bold.     This text is italicized. 
This text is bold and italicized.  This text is underlined. 
This text is in arial font.   This text is in Times New Roman font. 
This text is in Comic Sans MS font. This text is in currier font. 
This text is in size 12 font.   This text is in size 10 font. 

 
Text can also be reformatted by clicking  on the appropriate shortcut standard tool bar above 
the text area. 
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Page Setup 
 
Page setup is found under File on the menu bar as shown in the diagram to the right.  By 
selecting “page setup” with one click of the left mouse button a new window will appear.   Here is 
where margins are set and page orientation is selected.  Again, changes appear in the lower part 
of the window. 
 

 

Checking spelling and grammar 

With Word, the writer can check the spelling and grammar.  To check the spelling of a document, 
click on Tools and select Spelling and Grammar. (Or use the F7 key)  Word then gives the 
option to Ignore, Change, or Add the word to you dictionary. Remember that Word only checks 
for misspelled words and grammar errors; the document must still be checked for errors where 
the same sounding word may have more than one spelling.  Example – their or there. 
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Scrolling Through a Document 
 
Scroll Bar - The Scroll Bar is a grey vertical area on the right side of the window. There 
are arrows at the top and bottom of the Scroll Bar. Click on either arrow to make the 
contents on the page move up/down, one line at a time. Click on the small gray slide 
button between the arrows and drag up/down to gradually move the page contents. Click 
on the lighter gray area between the arrows and the darker box to make the contents 
move rapidly up or down.  Some screens may also have a Scroll Bar at the bottom of 
the screen to move the contents of the page to the right or left. 
 
If no Scroll Bar is present, this is an indication that “what you see” is all there is in the 
document.  If the Scroll Bar is present, this is an instant indication that there is more to 
the document than what is on the screen.  One needs to Scroll ‘down’ or to the ‘right’ to 
see the remainder of the document. 
 
Creating and Saving a File 
 
Files are created when a document has been typed into the 
computer on the screen.  When it is completed it likely needs to be 
saved on the computer hard drive.  To save a new file, click on 
File and go to Save As. 
 
 
 
 
 
 
 
 A new window appears called Save As.  Normally the computer will default to the My 
Documents folder where we store our files.  Near the top of this window there is an option to 
navigate to another folder or subfolder.  To do this, click on the down arrow to in the right of Save 
in box.  Then navigate to the desired folder. 
 
If the file is to be saved on another drive, we can 
navigate to that drive by first selecting My 
Computer.  Then select the desired drive to 
save the file. 
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finding the right file in the future. 
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Note: it is recommended to save a new file soon after it is started.  This may prevent loss of any 
data should an error with the computer  
occur. 
 
Saving Files 
 
After the file is saved and given a file name it can be easily saved with that same 
name.  Again, it is recommended to save often to avoid loss of data.  To save 
data without the step of giving it a new name, click on File and select save.  The 
file is then saved with the new changes since the last time it was saved. 
 
If the file needs to be saved with another name, 
use Save as and give it a new name.  This way the file will be saved both ways – 
in its original format under the original name and with the new changes under the 
new name. 
 
Practice creating files and saving them.  Try Save as and Save to see how each 
works and how save and name files. 
  
A key board shortcut to saving files is “Ctrl S.”  Hold the Control key down and 
press S and the file is automatically saved. 
 
 

My Documents is the folder where the user stores working files.  Typically it is the folder that 
most users go to for locating and accessing files.  New folders and subfolders can be created 
within the My Documents folder to organize and manage files.  This is explained during the 
discussion next week as we learn about Windows Explorer. 
 
 

 

 

It is always a good idea to periodically save your document.  On the File menu, 
click Save As.  When the Save As dialog box appears, give the new document a 
name and click Save.  Be sure to save your document into a folder and location of 
 your choice.  This will insure being able to find it for later use.  Save often! 
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Adding graphics to a document 

There are two basic types of graphics to enhance Word documents: 1.) Drawing objects, and 2.) 
Pictures.  Drawing objects include AutoShapes, curves, lines, and WordArt. Use the Drawing 
toolbar to change and enhance these objects with colors, patterns, borders, and other effects. 

Pictures include bitmaps, gifs, jpegs, scanned pictures and photographs, and clip art. Pictures 
from a scanner or digital camera can be inserted into a Word document.  

To insert a picture into a document 
 
First point and click with the left mouse button where the 
picture is to be inserted.  On the Insert menu, point to 
Picture, and then click From File.  Locate the picture to be 
inserted.  Double-click the picture to insert it. 
 
 
 
 
 
 
To insert clipart 
 
Click where the clipart is to be inserted.  On the Insert menu, point to Picture, and 
then click on Clipart 
  
Select a category by clicking a picture, or type a keyword in the Search box.  To 
insert the selected graphic, Click once with the left mouse button.  The graphic will 
appear in your Word document. 
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Formatting the picture or graphic 

Many times when the picture or graphic is inserted into a document, it will 
need resized and formatted.  To format a picture or graphic, go to Format 
on the menu bar and select Picture.  The following window will open: 
 
 

 

 

 

 

 

 

Point and click to each of the choices on the 
menu tabs on the above window.   
 
Under “colors and lines” options for borders 
and shading are found.   
 
“Size” provides options for resizing the 
picture. 

Options for “Picture” are shown in the above 
window.  Here is where the graphic can be 
cropped and brightness and contrast can be 
adjusted. 

           

© 2008, The Board of Regents of  the University of Nebraska on behalf of the University of Nebraska–Lincoln Extension.  All rights reserved.               16      
 



 

Chapter 1 
Introduction to Computer 
Operations 

 
 

Options for placing the graphic inside or outside of text are 
found in “Layout.”  The graphic can be located within the text 
as well.  Selecting tight allows the graphic to be moved 
around in the document.  The user should experiment with 
the different options to determine how the graphic is 
managed within the document. 
 

 

 

 

Errors 

Don’t panic, you can fix errors and even go back one or more steps. 

Undo             The Edit menu contains most of 
the commands you will need to fix 
errors. If you are a menu-oriented 
person, you will access this menu 
by clicking on Edit, then Undo. I 
feel that most of the commands 
on this menu are better utilized by 
keyboard shortcuts or by using 
buttons on the Toolbar.  

Shortcut: (Ctrl) Z; this selection will "undo" your most 
recent command. You will probably use this feature 

by clicking on the Undo icon on the Toolbar. When you invoke 
Undo from the Menu, the Undo command will be followed by 
the name of the latest command you performed.  
 
 
 
Redo 

Shortcut: (Ctrl-Alt) Z; as the opposite of Undo, Redo re-performs the last command. As 
with the Undo feature, you will probably use this feature by clicking on the Redo icon 
on the Toolbar. As with undo, the name on the menu will be followed by the name of 

the last command. 

Exiting Word  

Don’t forget to save your work before you exit Word. To exit Word:  
1. Click on File.  
2. Highlight Exit, which can be found at the bottom of the drop-down menu.  
3. Press Enter.  
4. If you have entered text, you will be prompted: "Do you want to save changes to 

Document1?" To save your changes, click on Yes. Otherwise, click on No. 
5. Specify the correct folder in the Save In box.  
6. Name your file by typing a name in the File Name field.  
7. Click on Save.  
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Tutorials and help 
 
Using Help on the menu bar will lead to an excellent place for instructions on how to us most 
Word Functions. 
 
Online Tutorials 
 
http://office.microsoft.com/en-us/word/default.aspx 
 
http://www.uwec.edu/help/word03.htm 
 
Go to Google and type in Microsoft Tutorials 
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In this chapter, participants will learn how to manage the computer.  Learning how to cut, copy, 
and paste, and how to manage folders and files makes working with the computer much easier 
and more efficiently.  Participants unfamiliar with the tips in this chapter will want to spend time 
practicing and learning how to use them. 
 
Cut, Copy, Paste 
 
Text can be copied and pasted in several ways. Text can be copied and pasted into another 
portion of the same document; or it can be pasted into a completely different document.  Also, 
text can be pasted into an entirely different program such as an e-mail message.   
 
Copying involves four basic steps: 
1. The computer must be told what is to be copied.  This is done by selecting the text to be 

copied.  This can be done with the mouse and left mouse button or from the keyboard us the 
shift and arrow keys.  With the mouse, point to the beginning of the text to be copied.  Hold 
the left mouse button down and slowly drag the mouse to the right.  To select more than one 
row at a time, drag the mouse down.  With the shift and arrow keys, put the mouse pointer at 
the beginning of the text to be copied.  Hold the shift key down and press either the right or 
down arrow key. 

2. The computer now needs to be told to copy the selected text.  There are many ways to select 
copy.  One quick way is with the right mouse button.  Point to the selected text and click once 
with the right mouse button.  A menu will appear which includes copy.  Point to copy and click 
once with the left mouse button.   
 
 

 
 
 
 
 
 
 
 
 
 
 
 
   
      Another method for selecting copy is to find the icon on the shortcut toolbar.   

Point and   click on it with the left mouse button. 

           

  
Still another method for selecting copy is to go to Edit on the menu bar and select 
copy.  To select copy from the keyboard, hold the CTRL key down and press the 
C key. 
 
Regardless of the step used to select copy, it is sometimes confusing because 
nothing happens on the computer screen.  But the computer now has the 
selected text stored in its memory, waiting for the next step. 
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3. Tell the computer where the selected text is to be copied to (pasted).  If the text is to be 

pasted somewhere in the same document, scroll to the desired location and click the left 
mouse button.  This is now the point where pasting will occur.  
 

4. Last we give the computer the command to paste. 
 
To Paste each of the methods described above for copying can be used. 
 
Notice in the image above paste is an option by clicking the right mouse button.  It is also found 
under Edit on the Menu Bar.  The keyboard shortcut to paste is CTRL V.  When the above 
commands are performed the selected text appears in its new location.  The text is now found in 
both locations in the document.  Note: The same selected text can be pasted multiple times.  It 
resides in the computer copy command until new text is selected and copied. 
 
The above procedure was copying and pasting text with the same document.  Text can be copied 
from any document and pasted other documents and/or files on the computer.  For instance, text 
can be copied from a Word document and pasted into the body of an email message.  Email 
addresses and WWW addresses can be copied and pasted to save retyping them.  To save time 
and retyping, practice copy and paste.  It makes many operations considerable easier to perform 
on the computer. 
 
In the above example we practiced with text.  The same procedure is used to copy images, 
graphics, charts and pictures.  They can be copied from one location and pasted in another 
desired location on the computer. 
 
Cut and Paste 
 
In the above example we learned how to copy text and paste it to a new location.  Many times, 
text will need to be moved from one location to another.  This is common when creating a 
document.  Perhaps the document would read better if a sentence or paragraph is moved to 
another location.   
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To cut and paste, we follow the exact same procedure as above only we use cut and not 
copy.  Cut  is found when we press the right mouse button, when we go to Edit on the 
menu bar, and there is an icon on the short cut bar for  Cut.   Notice the icon resembles a 
pair of scissors.  The user will notice when we cut the selected text disappears from the 

screen.  This many times causes anxiety because the user may think the material is completely 
lost.  Again the computer has it stored in its memory waiting to be told where to paste it. 
 
The key board shortcut to cut is CTRL X. 
 
Using ‘Control Panel’ to customize computer settings 
 
Control Panel is used to change many settings on your 
computer so it more closely fits your needs and preferences.  
If there is not a shortcut icon on the computer screen, Control 
Panel will be found by clicking on Start with the left mouse 
button and selecting Settings.   It can be accessed from other 
locations including in Windows Explorer. 
 
There are several tools within the control panel that allow the 
user to customize the computer to meet his or her specific 
needs.  A few of them are described in the following 
paragraphs. 
 
An example of a Control Panel screen is shown below. 
 

 
Add/Remove programs - is a wizard that guides the user through the process of adding 
software to or, deleting it from, the computer. It is important to use this function to help maintain a 
clean computer. It will also help add or remove window components. 
 
Date/Time - adjusts the date and time display on the computer. 

           

© 2008, The Board of Regents of  the University of Nebraska on behalf of the University of Nebraska–Lincoln Extension.  All rights reserved.               21      
 



 
 

Chapter 2 
Managing and Caring for  
Your Computer 

 
 

 
Display - controls the background color and design of the desktop, screen saver, screen fonts, 
icon styles, colors, and screen settings. 
 
Fax - allows the computer to send and receive faxes. 
 
Folder Options - allows the user to manage and customize various folder and file options. 
 
Internet Options - sets Internet browser controls such as home page, cache size, length of 
storage for, and viewing history list offline. 
 
Java Plug-in - Java is a script that shows special effects on some web pages. This feature allows 
configuration of the Java plug-in if it has been installed on the computer. 
 
Keyboard - configures or customizes the keyboard with special functions such as the typing rate 
and cursor blink rate. 
 
Mail - sets up user profiles for Microsoft Outlook. 
 
Mouse - allows changes in the default functions of the mouse. 
 
Network and Dial-up Connections - allows the user to join a network or to set up a dial-up 
connection to an Internet Service Provider (ISP). 
 
Phone and Modem - sets up an account with an ISP. 
 
Power Options - configures power usage and energy saving options. 
 
Printer - adds, removes, and configures available local and network printers for use on a 
particular computer. 
 
Regional Options - sets language, currency, time, and date settings. 
 
Scanners and Cameras - configures an installed scanner or camera attached to the computer. 
 
Sounds and Multimedia - allows the user to set different sounds for the computer operations 
such as alerts for new mail messages received, or when there is a program error, for example. 
 
Virus Scan - activates or deactivates virus protection software. 
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Computer Drives 
 
Computers typically have two or more drives from which to operate.  Double click 
on the My Computer icon. A new window will appear that shows more icons, or a 
list, of available drives.  

 
In the example to the right, this computer has “C” and “E” hard drives.  The “C” is the operating 
drive, while the “E” is an external hard drive used for automatically 
backing up data.   
 
It also as a “DVD,CD-RW drive installed.  The “F” drive in this example is 
a Removable Storage Device connected by a USB port. 
 
 
To see what is on a drive, simply click twice with the left mouse button 
on the drive in the “My Computer” window.  The window below shows 
what is in the “C” drive on this computer. 
 
 
 
Notice the size, type, and date the folder or  
file was modified is also shown. 
 
To see what is on the other drives, double 
click on them and a new window will appear 
with a list of folders and files installed there. 
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What is a File and what is a Folder? 
 
Electronic files and folders are just like hard copies that are stored in a file cabinet.  A Folder 
stores Files that are working documents. 
 
Like managing hard copies of files and folders, electronic files and folders must be managed to 
make life with a computer much easier.  Just like hard copies if there is no organization, 
electronic files can become lost or hard to find.  Much time is lost by trying to locate a file that is 
buried deep into a folder somewhere on the hard drive.  So periodically spending time to 
organize, create, and rename files makes operating a computer much more efficient. 
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Windows Explorer is the application that makes managing files very easy.  Every computer 
operator, especially those who save many files needs to learn how to use Windows Explorer to 
save, find, and open files.   
 
Using Windows Explorer to Manage Files and Folders 
 
Like most computer applications, Windows Explorer can be accessed 
in different ways.  The quickest and easiest is by using the right mouse 
button.  Click on the START button in the lower left corner of the 
computer screen with the right mouse button.  Notice in the 
window that appears, the second selection from the top is 
Explore.  By clicking on Explore with the left mouse button, the 
Windows Explorer screen will open. 
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Another method to open Windows 
Explorer is by clicking with the left 
mouse button on the START button.   
Then select Programs and scroll to the 
top of the menu to the right to 
Accessories.  Another menu opens to 
the right where Windows Explorer is 
found near the bottom.  A left click here 
will open the Windows Explorer Screen. 
 

  
If the computer has a 
Windows Explorer shortcut 
icon on the desktop screen, a 

click with the left mouse button will open 
Windows Explorer.  
 

 
The Windows Explorer Screen 
 
When the Windows Explorer opens, two frames appear.  The frame on the left is a list of the 
folders on this computer.  Each folder will contain subfolders and files.  Folders can be opened 
and closed by clicking once with the left mouse button on the box that has either a + (plus) or – 
(minus) sign.  To open a folder click on the + sign and to close a folder click on the minus sign.   
 
Practice opening and closing folders and see what is enclosed in each one.  As each folder is 
opened, the subfolders will appear below it and also in the frame to the right.   
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Programs can be opened from Windows Explorer by pointing and clicking with the left mouse 
button.  Many people use Windows Explorer to find and open their programs. 
 
 
Moving Files 
 
This allows easy movement of files from one folder to 
another.  The file can be copied from the frame on the 
right and pasted into a different folder on the left.  A 
quicker method to move files is to “drag and drop” them.  
Point to the file to be moved, hold the left mouse button 
down and move the mouse pointer to the desired file.   
 
Make sure the desired file is “lit” or “blue” before letting 
loose of the mouse button.  If it isn’t the file may 
disappear to another folder which sometimes can be 
difficult to find. 
Note: when moving files from one drive to another they 
are actually just copied from one drive to the other. They 
are not removed from the original location as they are 
when moving from folder to folder. 
 
 
Creating New Folders 
 
New folders can be created by clicking with the 
left mouse button on “File” on the menu bar.  At 
the top of the new menu New is found.  
Immediately a new menu will open to the right 
and Folder can be seen at the top of the menu.  
Left click on Folder. 
 
This results in a new folder appearing at the bottom of the right frame.  The folder will have the 
words New Folder blinking inside of it.  New folders can be 
created within any folder.  Usually files are stored in the My 
Documents folder.   As the number of files increases, 
subfolders should be created with in the My Documents 
folder to organize the files into various folders.    
 
To create a New Folder point to the folder and click once 
with the left mouse button.  Make sure the folder in which the 
New Folder is to be created is “lit” or “highlighted.”  The New 
Folder will go to whichever folder is selected, just make sure 
it is the one where the New Folder is to go to. 
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Another way to create a new folder is to click with the right mouse button in a blank area in the 
right pane of Windows Explorer, then click New>Folder with the left mouse button. 
 
Renaming Folders 
 
When a new folder is created and New Folder is blinking, it can be renamed 
by simply typing in the new name.  When typing is begun, the blinking New 
Folder will disappear and the new name will show up. 
 
Any folder can be renamed by pointing to it and clicking with the right mouse 
button.  Then select rename near the bottom of the menu with the left mouse 
button.  Again, type the new name into the box.  When naming files and 
folders, use names that can be easily remembered. For example, create a 
folder for financial records, another for pictures, and another one for letters. 
 
Changing the Appearance of Folders 
 
The way folders are displayed in the right frame of Windows Explorer can be 
changed. To do this, point and left click on View on the menu bar.  Choices for 
viewing are found near the middle of the new menu.  Notice Thumbnails, 
Tiles, Icons, List, and Details.   
 
 
To see how the folders appear, click on each one and see how they look in the 
frame to the right.  Notice how the list appears in Icon view in the window 
below.  The icon view is especially helpful when viewing folders that contain 
digital photos.  A small picture of each appears rather than the text showing the 
name and details of each. 
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Now, go back and click on Details and the view will change to something similar to the window 
shown below.  Notice in the Detail mode, more information about the file is given.  We can see 
the name, size, type, 
and the date the file 
was last modified.   
 
 
 
 
 
 
 
 
 
 
Changing the Order of How Folders are Arranged 
 
Folders can be displayed in many different ways.  They can be listed alphabetically, by size, by 
type, and by the date they were last modified.  To change the order of the folders, click on Name, 
Size, Type, or Date Modified found at the top of each column in the right frame.  By clicking on 
Name the files can be listed either ascending or descending alphabetically.  By clicking on Size 
the order will be from largest to smallest size or vice versa.  Type will put them in the order of 
folder type and Date Modified will list them from either newest or oldest.  This is convenient and 
handy when trying to locate a file.  

 
 
 
 
 
 
 
 

 
 
 
 
 

Date 
modified 

type size name 
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Deleting Folders and Files 
 
Folders and files can be deleted in several ways.  First point and 
click on the one to be deleted with the left mouse button.  This 
selects the folder or file to be deleted.  
 
 
 
Then press the delete key on the key board or click 
with the right mouse button once and select delete 
and click once with the left mouse button. 
 
When either of these methods is used to delete, the 
following warning window will appear.  This gives the 
user time to reaffirm that the selected file or folder is to 
be deleted. 
 
Remember if a folder is deleted, all of the folders within it 
are going to be deleted too. 
 
Selecting Multiple Folders of Files  
 
 If more than one file or folder is to be moved or deleted, 
there are two ways to select those files. 

1) if they are in consecutive order, point to the first 
and click once with the left mouse button down to 
select the beginning file.  Then hold the Shift Key 
down and press the down arrow key to select 
more than one file.   

 
2) if the user wants to select random files, first hold the Ctrl key down and point and click 

with the left mouse button on the files to be 
selected. 

 
Now all of the selected files can be moved or deleted 
at once. 
 
The above processes work the same when moving or 
deleting folders. 
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Cleaning Up the Hard Drive 
 
Computers should periodically be “cleaned up.”  This refers to the Hard Drive which many times 
stores lost and unused files.  Over time they become slow or sluggish due to the lack of 
organization of files and folders, and because of the many lost and unused files. 
 
To help with the above problem, hard drives can be “defragged” or “cleaned up.” 
Both of these are found in System Tools in the Accessories folder.   
 
Point to Start and click with the left mouse button.  Then navigate to Programs and to 
Accessories at the top of the menu to the right.  As Accessories opens, a new menu will appear 
to the right.   In this menu will be found System Tools.  Navigate to Disk Cleanup and Disk 
Defragmenter.  
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When Disk Defragmenter is 
selected a window similar to the one 
below will appear.  It may take a 
little time for this window to open.  
When it opens, select the drive to 
be defragmented which is usually 
the C or the Hard Drive.   
 
By left clicking on Analyze  red, 
blue, green, and white lines will 
appear in the “Estimated disk usage 
before defragmentation” frame.  
This will show the disk usage before 
it is defragmented.  A window will 
appear telling whether or not the  
disk should be defragmented.  If it 
does and hasn’t been done for a 
while, it may take several minutes to 
get it done.  It is suggested to do it when the computer is not being used, just get it started and 
periodically check on it.   
 
When it is completed, the red, blue, green, and white lines will appear showing the hard drive 
usage before and after it was defragmented. 
 
Using Disk Cleanup 
 
Follow the same procedure as above only select Disk Cleanup.   
A window similar to the one to the left will appear.  Again select 
the C drive and click on ok.  A new window will appear which will 
tell whether to continue or not with cleanup. 
 
Hard Drives should be checked periodically for defragmenting 
and cleaning up.  Laptops that are used excessively should be 
checked monthly. 
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In this chapter we will learn the basics of the Internet and how to use it.  We will begin with 
understanding a few terms followed by getting on the Internet and start surfing.  We will learn how 
to use search engines, directories, and how to type in urls to find information.  The class 
concludes with learning how to save and print information from the Internet.  Your instructor will 
help find and learn about specific web sites and topics that interest the class.  

How Web Browsers Work 
 
Most of the information on the Web is organized on Web sites located on computers connected to 
the Internet. Computers that specialize in storing and delivering Web-based information are called 
Web servers.  For a computer to request information from a Web server, it must use a software 
program called a browser.  Internet Explorer is one of several browser software programs. 
 
Use the browser to request information from the Web in two ways.  Type the URL or Internet 
address of the Web site in the address bar of the browser or put the cursor over a hypertext link 
for more information about hypertext links) and click on it.  The browser sends a request for that 
Web page or site over the Internet to the host server.  When the server receives the request, it 
finds the page, then sends a copy of it over the Internet to the local computer.  When the data 
arrives, the browser displays the page or site and any images associated with it in the browser 
content window.  The speed of this action is dependent upon the speed of the Internet 
connection.  Ideally, the action should be completed within seconds. 

Understanding URLs 
 
The World Wide Web (often abbreviated 
as WWW) currently is the most popular 
Internet protocol.  References to the 
Internet and the World Wide Web are 
everywhere.  A URL (or Uniform Resource 
Locator) is an Internet address.  URLs 
follow this format: 

 
Examples of other URLs: 
 

 http://www.whitehouse.gov  
 http://redcross.org  
 http://www.usatoday.com  
 http://www.ianr.unl.edu 
 http://www.af.mil 
 http://www.huntel.net 
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No two computers connected to the Internet can have the same name.  To simplify the process of 
naming millions upon millions of computers on the Internet, the Domain Name System was 
developed.  There are six top-level domain names or subgroups that most computers on the 
Internet belong to: 

 .gov (government) 
 .mil (military) 
 .net (networking organizations like Internet Service Providers) 
 .org (nonprofit organizations) 
 .com (commercial) 
 .edu (educational institutions) 

 
When the Internet became international, additional top-level domain names were added that 
corresponded to the two character ISO country codes (e.g., us for United States).  Additional top-
level domain names introduced in 2001 and 2002 include: 
 

 .aero (air transport industry) 
 .big (businesses) 
 .int (organizations established by international treaties) 
 .museum (museums) 
 .info (unrestricted use) 
 .pro (professionals) 

 
Some Web sites include a tilde symbol (~) in the URL.  (This symbol is located next to the 1 on 
most keyboards.)  Some ISPs will host Web pages for subscribers.  The tilde indicates that a 
Web page resides on disk space that the ISP has allocated for a subscriber.  Incoming e-mail is 
another example of something that is stored on the subscriber’s disk space. 
 
File names often end in the extension .htm or html.  HTML which stands for Hypertext Markup 
Language is the name of the computer coding language used to create Web pages.  Some 
servers that host Web pages can only handle three letter extensions and use .htm instead of 
.html. 
 
Important:  URLs can be case sensitive.  When in doubt, use all lower case.  If a URL uses mixed 
case (upper and lower case), type it exactly as printed. 
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Tour the Web Browser Internet Explorer 
 
A software program called a Web 
browser allows a user to access 
information from the World Wide 
Web.  Microsoft Internet Explorer 
is the most widely used browser. 
 
The Windows Title Bar tells which 
program is running in the window 
and the name of the document 
being accessed. 
 
The Pull-Down Menu Bar 
organizes a variety of functions 
and features that can be used to 
navigate the Web more effectively 
and efficiently. 
 
The Standard Buttons Toolbar 
makes it easy to access the 
features used most often. 
 
 
 
The Address (Location) Bar shows the URL or Web page address being viewed or downloaded.   
 
The Content Area displays the page currently being accessed. 
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Commonly Used Navigation Icons 
 

 
Click the Back or Forward buttons on the browser toolbar to revisit Web pages.  
The browser remembers the pages viewed most recently and stacks them.  But, 
it is much more efficient to click and hold down the Back or Forward arrow     

buttons.  A list of the most recent sites visited will appear.  Go directly to the desired page by 
clicking the name of the page in the list. 

   

 
tarting 

page. 
 

dd Web sites within the Explorer Bar, as well as, 
in the Favorites pull-down menu. 
 

oogle Search Window 

m.  

ic.  
ered in the Google Window but the website will appear in the list of hits in the 

oogle search. 

site 
t URL is not known, then the 

earch is begun by typing key words into the Google window. 
 

 
Use the Stop button, to stop the download of a site.  When a download is slow, it 
may help to click Stop then Refresh.  Refresh also updates Web sites that include 
“up-to-the-minute” information like CNN or USA today. 
 

Home returns to the page that has been specified as the Home Page or s

 
Favorites launches the Explorer Bar that contains a personalized list of frequently 
visited Web sites.  Organize and a

 
 
G
 
Most browsers now have a Google Search Window or even a Google Toolbar installed on the
New Internet users commonly confuse the Google search window with the address window.  
Remember the address window is where urls are entered to access a web page.  The Google 
Search Window is where key words are entered to search for web sites related to a specific top
URLs can be ent
G
 
If the URL of the site is known, it should be typed in the Address Window.  This way the web 
will appear when “Go” or the “enter” key is pressed.  If the exac
s

 
 

Google Search Address window 
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Getting Started on the Internet 
  
Most people begin searching the Internet by typing in URLs or Web Addresses into the addre
bar.  URLs are found everywhere anymore and the website can be accessed by typing the U
in the address window. 
 
Many web address begin with “HTTP.”  Usually this does not need to be typed in, we simply 

ith the w W   Let’s start by typing in the following URL.  www.huskers.com.  After typing in the 
r or click on the green go button. The Huskers Web Site will appear on the URL, press ente

creen. s
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ng the Internet. 

xamples are: 
 
www.mapquest.com
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To begin, roll the mouse around the content area of the screen.  When the mouse pointer takes 
on the appearance of a “hand” we have come to a “clickable link” which will take us to another 
location in this website.  When the “hand” appears we can click with the left mouse button to 
activate the link and go to the new location.  Practice clicking on the various links and using 
“back” and “home” to begin browsi
 
Your instructor will guide you through many examples of web sites to practice browsing the 
Internet. 
 
E

 
www.weather.com 
www.switchboard.com 
www.nebraska.gov 
www.horsecity.com 
www.antiquecar.com 
www.unl.edu 
www.hispanicsurf.com 
www.4h.unl.edu 
 
Searching for Inform
 
Information can be gathered
listings of Internet resources
categorize listings.  Not all si
include sites that meet cer
 
Search engines such as G
Internet by keywords.  The
rawlers to 

ation on the Web 

 on the Web by using directories and search engines.  Directories are 
, usually by topic.  Directories rely on people to submit and 
tes are indexed in particular directories.  Some directories only 

tain criteria.  Use directories for searches on general topics. 

oogle, Teoma and MSN Search attempt to index every site on the 
se search engines use software agents called spiders, bots, or 

scour the entire Web to search the Internet, index the sites, and build a database.  
 databases to find information on specific topics.  Users will achieve 
engines when using keywords specific to the topic being searched. 

http://www.yahoo.com

c
The user can search those
better results from search 
 
Directories 
 

 Yahoo   
art  http://www.looksmart.com LookSm  

 

ogle  http://www.google.com

Primary Search Engines 
 

 Go  
 MSN  http://search.msn.com 
 Teoma  http://www.teoma.com 
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Practice some simple searches.  For example, search for information about gardening.  Go to 
Yahoo (http://www.yahoo.com.  Although the Yahoo database is searchable, start by browsi
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ng 
rough the directory listing.  From the main directory, choose Recreation and Sports.  Then, 

cho ning.  Explore the listings or go into the 
ubdirectories under Gardening. 

 
Next, try to u f the most popular since it 

ffers the largest collection of Web pages of any crawler-based search engine.  It is especially 
helpful in findi
 

Search for th

Type the key
million site
 
Googl

ngines rate how well the 

e sites may not 
e particularly relevant to 

th
ose the subdirectory Hobbie, then Lawn and Garde

s

se a search engine such as Google.com.  Google is one o
o

ng good sites in response to general searches by category or directory. 

e keyword gardening.   
 

word in the space provided and click on Google Search.  The first 10 of nearly 10 
s that include the keyword, gardening will appear. 

e and other search 
e
site matches a query and 
lists the most relevant sites 
first.  But, th
b
the user.  (As the Google 

atabase is updated, the d
results of the same query 
may vary.) 
 
Search engines allow the 
user to narrow a query to 
achieve more accurate 
results.  (Since there are 
millions of Web sites, 
earch engines streamline s

the process.)  There are 
some differences in the 
basic and advanced search 
features of the various 
search engines. 
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ible. 

ages that include all search terms.  It is 
to place the word and between the terms. 

nd characters such as where and how, as well as 
If a common word is essential for the desired 
e and a plus sign (+) before the word.  To exclude 

e word to the search box with a space and 
rch for all documents containing a c

ng of words in the search field 

r case. 

 Google searches for the exact words typed in the search box. Use these hints to 
narrow the query further.  Search for: gardening perennials oriental lilies.  This will 

lled Star Gazer, type 
ardening perennials oriental lilies star gazer.  The search has been narrowed to about 788 

veryone has a list of web sites they commonly 
use.  To organize our favorite websites, we can 
store them in our Favorites in our browser.  Or 
many times we will spend considerable time 
searching for information and the URL becomes 
quite long and difficult to remember or type in.  
Favorites is a great place to store such web sites 
and to quickly return to them at a later date.   
 
To add a Web site to the Favorites list, click on 
Favorites and then Add to Favorites.  The name of 
the site appears in the Name field of the menu box 
that opens.  To save the Web site or page with the name as it appears in the Name field, click OK 
and it will be placed at the end of the Favorites list.  Practice going to a few web sites and add 
them to the favorites on your computer. 
 
View the Favorites list to find the names of the Web sites.  To change the name of a Web site, 
type a new name in the Name field within the Add to Favorites menu box before clicking OK.  A 
name that is recognizable to the user is recommended. 

Now, narrow the search.  Click on Advanced Search to the right of the search box.  The Google 
Advanced Search page appears.  Then click on Advanced Search Tips on top to the right. 
 

 Make keywords as specific as poss
 

 By default, Google only returns p
unnecessary 

 
 Google ignores common words a

certain single digits and letters.  
result, include it by putting a spac
certain words from searches, add th
minus (-) sign before it.  To sea
put quotation marks around the stro
phrase. 

 
 Google searches are NOT case sensitive.  All letters are understood as lowe

 

ertain phrase, 
that make up the 

deliver a list of around 17,000 documents.  This is a smaller, but still somewhat 
unmanageable list. 

 
Now, be more specific by adding the name of an oriental lily cultivar ca
g
documents 
 
Favorites Pull-Down Menu 
 
E
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Because adding Web sites to the list of favorit

ng to be efficient.  However, by organizing th
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e pages is so easy, Favorites lists often grow too 
e Favorites into folders by topic, the list can be 

ept manageable and easy to revisit.  To 
organize the Favorites list click on Favorites and 
then Organize Favorites.  Here a user can 
create folders, rename or delete Web sites, or 
move Web sites to folders. 
 
To create a new folder click Create Folder.  At 
the end of the list a new folder appears with a 
box beside it that says New Folder.  Type in a 
name for the New Folder and press Enter on the 
keyboard or click the left mouse button.  Try 
moving some of the Web sites in the list into the 
new folder.  Click on a Web site with the left 
mouse button and, while holding the button 
down, drag the name of the Web site to the new fold  the new folder 
becomes highlighted, release the mouse button.  The Web 
folder. 
 
Or, move Web sites in the Favorites list in and out o
To do this, highlight the Web site to be moved by cli
click Move to Folder.  A new menu box appears co he folders that have been 
created.  Click on the folder where the Web site is to o and click OK. 
 

o delete a Web site from the Favorites list, highlight it and click Delete.  

To rena e a Web site, highlight it and click Rename.  When a box appears around the old name, 
 on the keyboard or click the left mouse button. 

lo
k

Organize Favorites

er.  When the name of
site will be placed in the highlighted 

f folders by using the Move to Folder button.  
cking on it with the left mouse button.  Then, 
ntaining a list of t
 g

T
 

m
type in the new name and press Enter
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Changing the Browser Home Page 
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The Home Page is the web site which 
appears when the browser is opened. It can 
be set to the site preferred by the user.  It is 

e the browser Home Page. 

ft Mouse Button on 
Bar.  Select Internet 
lowing Window appears. 

ndow there are two options for 
setting the Home Page.  One option is to 

e the URL of the Web Site in the window 
shown to the right. 

 
her 

s are to use the Windows default site 
or “Use Blank.” 

ave a Picture from the Web 

n 
gner 

r 

ted 
y 
 

age be included if their picture is used on another web page. 

 

easy to chang
 
Click once with the Le
Tools on the Menu 
Options and the fol
 
From this wi

typ
as 
 
The other option is to first navigate to the 
Web Site that is to be the Home Page.  Then
click on the “Use Current” button.  Ot
choice

 
 

 
 

S
 
It is against copyright regulations to use pictures from the internet 
without permission.  If a graphic copied from one web site is used o
another web site or in published material, permission from the desi
must be obtained. 
 
However, many web sites offer free graphics for web pages and/o
clipart that can be used in printed documents.  Yahoo 
(www.yahoo.com) lists a number of these web sites.  Most are lis
under the Computers and the Internet/Graphics category.  Man
designers require that credit be given and/or that a link to their web
p
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rowsing the Internet  

 

ight click on the image.  When the dialog box 

Background 

m the Internet can be used as background images on 
mputers.  Locate the picture on the Internet and right click on 

n menu of Picture Display, 
th different versions of 

 a Web Page 

type correctly.  To copy a site’s URL, high
  Open the document where the URL is to be inserted, then 

 web page, highlight the text and follow the same 
t into a document. 

opy and paste is a time saving method to save information including URLs from the Internet.  
formation can be copied and pasted into Word documents or other folders where it can be 

aved for further reference.  Care must be taken to avoid downloading copyrighted material. 

rint 

n Next to find the page to be.  Select the 
esired page(s) to avoid printing more material that was needed 
r wanted. 

o print selected web pages, use Print Preview.  Click File>Print 
review to see what the printout will look like. Scroll through the 
ages by clicking on Next to find the page to be.  Select the 
esired page(s) to avoid printing more material that was needed 
r wanted. 

 
 
 

B

Chapter 3 
 

 
For practice, go to, http://coloquio.com/ and r
appears, select Save Picture As.  When a Windows folder appears, choose a directory and folder 
where the picture is to be saved, rename the picture if desired, then click Save.  Remember 
where the image is saved for later use. 
 
Saving a Picture as a 
 
Pictures fro

esktop cod
the picture.  Select Set as Background).  To center the image, rather 
than having it tiled, click My Computer>Control Panel>Display.  Select 
the Background tab.  Under the drop dow
check Center.  The last step may vary wi
Windows. 
 
Copying URLs and Text from
 
URLs can be difficult to remember and 
the Location box.  Select Edit>Copy.
select Edit>Paste.  To copy text from a
copy/paste procedure to place the tex

light the URL in 

 
C
In
s
  
Print a Web Page – Print Preview 
 
To print selected web pages, use Print Preview.  Click File>P
Preview to see what the printout will look like. Scroll through the 

ages by clicking op
d
o
 
T
P
p
d
o



 

Chapter 4 
Safety and Your Computer  

 
 

         
chapter will teach how to use features of your computer and browser to keep your computer 

 
This 
                                                  

safe.  Safety to your co hat are discussed in this mputer and safety to the user are concerns t
chapter.  You will lea  web sites your computer has rn how to search for information leading to
visited.  To conclude this series of computer classes, we will learn how to keep the computer user 
safe while on the Internet.  
 
History 
 
The browser stores web sites that have been recently typed into 
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the address window.  They are 
und in the History folder in the 

indow appears in the drop down 
indow.  If a web site that is to be 
isited is found in this list, click on it 
nce with the left mouse button.  The 
eb site will open in the browser.   

o adjust the number of days that Web sites are 
er, click on the up/down 

 to the Clear History button.  The 

fo
address window.  To access the History 
list, click once on the “down arrow” 
found at the right end of the address 
window.  A list of the web sites that 
have been typed into the address 

History Button w
w
v
o
w
 
 
 
 
 
T
retained in the History fold

rrows in the field nexta
Clear History button eliminates all the links from in the 
History folder.  
 
 
 

History  
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with 

ites the computer has visited, not just the 
nes that were typed in as found in the history list found in the 

 by clicking 
n the desired time frame.  Web sites can be deleted from this 

elete” key on the computer key board. 

etween the user’s computer and the Web server.  Cookies are implemented to allow user-side 
e used to customize Web searches; 

d to store shopping lists of 
ore. 

 

servers.  In 
ticed, and so 

oes access to it.  Web servers automatically gain access to relevant Cookies whenever a user 

 

History and the Back Button 
 

 
Another folder that stores even more web 
site is found under the “back” button.   

Again, by clicking once with the left mouse button on the 
“down arrow” just to the right of the back button, a folder 
recently visited web sites will open.  One will notice this list 
includes all web s
o
address window. 
 
From this window we can access web sites that were visited by 
weeks or days of the week.  Each can be expanded
o
list by selecting them with the left mouse button and pressing the 
“d
 
 
 
 
 
 
 
 
Internet Cookies 
 
Cookies are pieces of information generated by a Web server and stored in the user’s computer, 
ready for future access.  Cookies are embedded in the HTML information flowing back and forth 
b
customization of Web information.  For example, Cookies ar

 allow a user to participate in online contests (but only once); anto
items a user has selected while browsing an online st

Cookies make use of user-specific information transmitted by the Web server onto the user’s 
computer so that the information will be available for later access by itself or other 

n into a Cookie generally goes unnomost cases, the storage of personal informatio
d
establishes a connection, usually in the form of a Web site request. 
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.  First, the Cookie is stored in the user’s computer 

with customizable Web search engines such as My 

okie list.  This happens without any notification or user 
t, personal information (in this case  
preferences) is formatted by the Web server, transmitted, and saved by the 

and automatically transferred from the 
irects the Web browser to display a certain 

ledge, transmit the Cookie 

er Group (BUG) of Melbourne, Florida, http://bugclub.org

 

Cookies are based on a two-stage process
ithout consent or knowledge.  For example, w

Yahoo!,  a user selects categories of interest from the Web page.  The Web server creates a 
specific Cookie, a tagged string of text that contains the user’s preferences, and transmits this 
Cookie to the user’s computer.  The user’s Web browser, if Cookie-savvy, receives the Cookie 

nd stores it in a special file called a Coa
consent.  As a resul
he user’s category t

user’s computer. 
 
During the second stage, the Cookie is clandestinely 

ser’s computer to a Web server.  Whenever a user du
Web page from the server, the browser will, without the user’s know
ontaining personal information to the Web server. c

 
ource:  Brevard’s UsS  

iruses are executable programs that attach themselves to programs or data files.  They usually 

d 

  They 
y. 

enerally, viruses are not spread by reading and sending e-mail or browsing Web pages.  If a 

at now appear 
n many Web sites . 

uidelines to minimize possible damage from viruses: 

stall a virus protection program and run it regularly.  Set your computer to regularly access the 

 
Can a computer get a virus from using the Internet? 
 
YES!!  It is becoming more common for viruses to be transmitted via the Internet and e-mail. 

 
V
attack four parts of a computer–the executable program files, a file directory system that tracks 
the location of the computer’s files, the boot and system area needed to start the computer, an
the computer’s data files.  Trojan horses are files or programs disguised as being normal and 
helpful.  Worms are programs designed to infect computer networks such as the Internet.
travel from networked computer to networked computer replicating themselves along the wa

 
G
program is downloaded, there is a chance that it could be infected with a virus.  Also, there is a 
slight chance that a virus could be contracted from running the Java applications th
o
 
G
 
Download files only from reputable Internet sites. 

 
In
Internet for virus updates and upgrades to insure protection is always up to date.  
Perform system and data backups regularly. 
 
If concerned about infecting a computer with Java applications, set the preferences on the 
browser to not run Java.  
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Is the Internet safe for children? 
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urces for children.  However, it has a dark 
unsupervised.  To make surfing the Web safer 

l world. 

at is available on the Internet and 
arding children’s Internet use. 

ts have the right to see what sites children visit and with 

en see or read questionable material, they should be encouraged to 

hen pa
e of the 

ne 
it card number, etc.) to anyone over the Internet without permission. 

 
Parents legal rights as parents of children who use the Internet.  Before a site 

ure, use, or share information about children, parents must 
x, or phone. 

that don
 

 (http://www.ofoto.com

 
The Internet can provide excellent educational reso
s d  and parents should not leave children totally i e
o c if r h ldren, follow these guidelines: 

 
Set ground rules. 
 
Maintain trust between parent and child. 
 

espect children’s privacy, as long as they are safe. R
 

e realistic.  Think about what they see and hear in the reaB
 

eep children safe. K
 
Go online with the child.  Spend time on the Internet.  Learn wh

enable better decisions reghow it works.  This will 
 
Monitor children’s online activities.  Paren

hom they visit in chat rooms. w
 

stablish rules.  When childrE
show it to their parents or talk to them about it.  Clear guidelines about appropriate use of the 
Internet should be established.  For instance, decide whether children should use the Internet 

rents are not at home.  Decide how long they are allowed to use it and for what w
purposes.  Parents must be clear about what the consequences of inappropriate us
nternet will be. I
 
Explain to children that they should never give out personal information (name, address, pho
number, cred 
 
Parents should be aware of Internet sites visited when children visit the homes of friends. 

 should know their 
targeting children under 13 can capt
be notified by e-mail, regular mail, fa
 
Protect passwords and create hard-to-decipher user names.  Teach children to create aliases 

’t use their real names, ages, or gender. 

Be wary about posting family photos in Web sites.  Ofoto.com ) allows 
tected.  Only those who know the people to create online phone albums that are password pro

password can view the family photos online. 
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 available.  Some of these programs 

wing sites: 

 

Programs designed to block out objectionable material are
n the Internet.  Check the follocan limit the amount of time spent o

 
 Cyber Patrol – http://www.cyberpatrol.com 
 Cybersitter – http://www.solidoak.com 
 Net Nanny – http://www.netnanny.com 

 
WARNING:  These programs are not foolproof! 
 
The U.S. Department of Education’s Parent’s Guide to the Internet offers safe surfing advice and 

 listing of children’s sites: http://www.ed.gov/pubs/parents/internet/a  
 
Consider using an ISP that blocks out questionable sites. 
 
For more information about Internet safety visit: 
 
http://www.netsmartz.org/ 
http://www.komputers4rkids.com/Protection.html 
http://www.kidzui.com 
http://safekids.com 
http://www.fbi.gov/kids/k5th/safety2.htm 
 
Tips for parents of teens: 
 
Know teens’ online habits.  How are they spending their online time–in chat rooms, downloading 

music, etc.  Advise them to keep their e-mail addresses as private as possible. 
 
Locate the computer in plain site.  Teens need to know they are being monitored. 
 
Tell teens to be very wary of chat rooms, they can be dangerous.  Most chat rooms are not 
moderated. 

 
Children can come across inappropriate material distributed by adult Web sites.  Although not 

foolproof, install a utility such as Spam Killer (http://www.spamkiller.com) that blocks 
unwanted e-mail. 

 
Enforce time limits on Internet use. 

 
Scrutinize the browser’s history file.  Children who do not want parents to know what they have 

been viewing online can clear the history file.  If this is often the case, parents should pay 
closer attention to them while they are online. 

 
Control family members’ Internet accounts and passwords. 
 
Outwit online fraud.  According to the Internet Fraud Watch, Web auctions are the most common 

paths to fraud.  Restrict online purchases without permission, even if teens have personal 
credit cards.  

 
If your child reports suspicious occurrences, notify the proper authorities.  If a child is being 

stalked online, inform local authorities. 

http://www.matisse.net/files/glossary.htm
http://www.matisse.net/files/glossary.htm
http://www.learnthenet.com/english/index/html
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Additional Training Availab
(Visit these Web sites if available.) 
 
Glossary of Internet Terms – http://www.ma /glossary.htm

 
le on the Internet 

tisse.net/files  
 
Learn the Net – http://www.learnthenet.com/  
 
Internet for Beginners – http://www.netforbeginners.about.com 
 
50 Killer Browser Tips – http://www.pcworld.com/resource/printable/article/0,aid,9495,00.asp 
 



 

 
 

Computer Basics 

Chapter 1 

 

Evaluation  

 
After taking this class, Stayed 

the same 
Increased 
somewhat 

has your knowledge of Increased Increased 
each of the following:  greatly 

The mouse and the mouse pointer 
    

    
Learning about the Desktop and shortcut icons  

Starting and opening programs 
    

Windows – opening, resizing, closing 
    

Control Panel for computer settings 
    

Naming and saving files 
    

Files, folders, drives 
    

Overall Rating of the Class Ok Good Very good Excellent 

How would you rate this class as a whole 
    

Did you learn something that you will be able to use on your job or in 
ur business? 

Yes No 
yo
 
 
 
Overall comments: Tell us what you liked about the class, something you learned, what you liked 

 what we could change to make it better. or
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Computer Basics 
Evaluation  
Chapter 2 

 
After taking this class, has your knowledge of 
each of the following:  

Stayed 
the same 

Increased 
somewhat 

Increased Increased 
greatly 

Cut, Copy, Paste 
    

Control Panel and how to use it 
    

What is a “file” and a “folder” 
    

Creating new folders 
    

Moving folders and files 
    

Rename and delete folders and files 
    

Cleaning up the hard drive 
    

Overall Rating of the Class Ok Good Very good Excellent 

How would you rate this class as a whole 
    

D
yo
id you learn something that you will be able to use on your job or in 
ur business? 

 
 

Yes No 

Overall comments: Tell us what you liked about the class, something you learned, what you liked 
 what we could change to make it better. 

 

or
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Computer Basics 

Evaluation  
Chapter 3 

 
After taking this class, has your knowledge of 
each of the following:  

Stayed 
the same 

Increased 
somewhat 

Increased Increased 
greatly 

Browsers and how do they work? 
    

Understanding of URLs and Web Addresses 
    

Accessing a Web Site 
    

Using Search Engines 
    

Navigating a Web Page 
    

Overall Rating of the Class Ok Good Very good Excellent 

How would you rate this class as a whole 
    

Did you learn something that you will be able to use on your job or in 

 
your business? 

 
 
 
 

Yes No 

Overall comments: Tell us what you liked about the class, something you learned, what you liked 
 what we could change to make it better. or
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Computer Basics 
Evaluation  
Chapter 4 

 
After taking this class, has your knowledge of 
each of the following:  

Stayed 
the same 

Increased 
somewhat 

Increased Increased 
greatly 

Using your browser History 
    

Using History found with the Back Button 
    

Internet Cookies 
    

Computer viruses 
    

Internet Safety 
    

Overall Rating of all of the four classes Ok Good Very good Excellent 

Your instructor(s) 
    

The class as a whole 
    

Did you learn something that you will be able to use on your job or in 
your business? 
 
 
 
 
 

Yes No 

Overall comments: Tell us what you liked about the class, something you learned, what you liked 
or what we could change to make it better. 
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